
 

 

 
INSTRUCTIONS FOR FY 2026-2027 DIRECT CHARGES 

 
 
A. Requirement for New Assessments Only:  

If you are levying a direct charge for the first time in FY 2026-2027, or if you are submitting a new 
direct charge for this fiscal year, please submit new direct charges separately from existing ones 
following the steps below: 
 

1. Complete the New Direct Charge Request Form 
A separate form for each direct charge must be submitted. The form can be downloaded 
from the following link:  New-Direct-Charge-Request-Form.pdf 
 

2. Provide a Signed Resolution 
A resolution to authorize the new direct charge must be signed and provided to us so the 
appropriate tax type and district number coding can be assigned in the County’s Property 
Tax System. 

 
3. Submit the Agreement for Collection of Special Taxes, Fees, Charges, and Assessments 

This agreement must be signed by an authorized representative of your city or special 
district and approved by the governing body. The Direct Charge-Special Assessment 
Agreement template can be downloaded from the following link: 
Direct Charge-Special Assessment Documents – Orange County Auditor-Controller  

 
*Note: This step is required only if your district is levying a direct charge for the first time. 
The agreement will remain in effect annually unless either party terminates it. 
 

4. Email All Documents 
Email the completed documents with the subject line “New Direct Charge Request – 
[Name of Direct Charge]” to: ptax@ocauditor.gov 
 
 
 
 
 

  

https://ocauditor.gov/wp-content/uploads/2025/01/New-Direct-Charge-Request-Form.pdf
https://ocauditor.gov/about/central-accounting/property-tax-accounting/direct-charge-special-assessment-documents/
mailto:ptax@ocauditor.gov
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B. Requirements for New or Continuing Direct Charges: 
 

I. Authorization:  

To be included to the Secured Property Tax Roll, the board resolution for direct charge must be 
authorized by your city/special district’s governing body and certified by your governing body’s clerk.  
 
II. Parcel Listing: 

In June, once Assessor makes the parcel listing available, the Auditor-Controller will post by the 
city/special districts to the https://epts.ocauditor.gov/direct/login public folder.   
Refer to Attachment A for instructions of extracting this listing. 
 
The parcel listing will: 

• Reflect the status of property ownership as of the lien date of January 1, 2026.   
• Include the APN type (APN type 1 – Common Area Parcels; APN type 2 – Wholly Exempt 

Parcels; APN type 3 – All Other). 
• Exclude public utility parcel numbers.  If you have direct charges to be added to public utility 

parcels, the following information must be submitted: 

(a)  Tax Rate Area 
(b)  Name of Public Utility 
(c)  Amount of Assessment 

 
A file showing cross-reference between new parcels and old parcels will be available from the 
County Assessor for you in determining the disposition of obsolete parcels and the sources of new 
parcels.  Please contact the County Assessor to obtain this information. 
 
III. Submission and Format/Input Requirements: 

Submit direct charge data and signed resolution (in PDF) via https://epts.ocauditor.gov/direct/login.   
 
Refer to Attachment B for data format and Attachment D for online submission tool.  
      
General rules for your submission:  

• All data files must include District ID#, Tax Type, and City or Special District. 
• Weed Abatement Programs: Only one (total) amount should be referenced per parcel.  
• Control totals: The total number of records and the total dollar amount for each direct 

charge must be provided and reconciled to the data file provided to us at the time of 
submission.  

• Contact: The contact person who can answer the public’s questions regarding the direct 
charge must be included with your submission.  This information will appear on the property 
tax bill.  Use Attachment C. 

https://epts.ocauditor.gov/direct/login
https://epts.ocauditor.gov/direct/login
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IV. Timeline: 

June:  Parcel listings to be available. 
August 1:  Deadline to submit water district assessments (per Water Code Section 31701) 
August 10: Deadline to submit all other direct charges. Any late submission requires advance 

approval from Auditor-Controller’s office.  
 
*Note: All files, including the corrections, need to be submitted by the due date to be included on 
the tax bills.  
 
V. Processing of Corrections: 
 
If submitted data fails our edits, your intended direct charge will not be added to the tax bills. We 
will provide you with the parcels that have failed our edits. You can re-submit the corrected data 
via https://epts.ocauditor.gov/direct/login using the standard format as defined in the 
instructions by the due date.  

Important: When submitting the corrections, do not include parcels which have been previously 
processed as valid transactions.  Submit corrections ONLY for those parcels in error notified by us.  
Duplication of submission may increase your intended charges on the tax bills. 
 
Once the secured tax roll has been extended to the Treasurer-Tax Collector, any subsequent 
corrections will incur a $15 processing fee per parcel.  This fee must be submitted to the Auditor-
Controller at the time of the change or deletion request.  Additionally, if new parcels are added that 
were not part of the original submission, a cumulative fee of $15 per parcel plus 0.30% of the added 
amount will apply. 
 
For any questions, please contact Roeth Bun at (714) 834-2609, roeth.bun@ocauditor.gov 
or Samantha Nguyen at samantha.nguyen@ocauditor.gov  
  
 
 
 
 
  

https://epts.ocauditor.gov/direct/login
mailto:roeth.bun@ocauditor.gov
mailto:samantha.nguyen@ocauditor.gov
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Attachment A 
 

District Parcel Listing Extract Format 
(AT04BB01) 

         
             

  Record Description Number of Characters 
Relative 
Positions   

            
  01 District Record        
    02 District Number 4 1-4   
    02 Tax Rate Area 5 5-9   
    02 Parcel number 8 10-17   
    02 (Blank) 2 18-19   
    02 Zip code 10 20-29   
            
  02 Name & Address        
    03 Segment 1 25 30-54   
    03 Segment 2 25 55-79   
    03 Segment 3 25 80-104   
    03 Segment 4 25 105-129   
    03 Segment 5 25 130-154   
    03 Segment 6 25 155-179   
    03 Segment 7 25 180-204   
    03 Segment 8 25 205-229   
            
  02 APN Type Code 1 230   
         

  
Records are 230 characters in length 
   

Parcel Listing files are in text format and located on the Auditor-Controller Direct Charge Upload 
Server. The files are displayed as follows: 
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Instructions For Extracting Parcel City Listing Information 
 
Steps: 

1. Download and save the source file “AT04BB” from Auditor-Controller Direct Charge upload 
server. Initial data will be displayed as below: 

 
 

2. Open a new excel spreadsheet. 
3. Go to the Data Tab. 
4. Select Get Data->From File->From Text/CSV. 
5. Locate the downloaded and saved source file “AT04BB” and import. 
6. Change the “Delimiter” parameters to match the parameters below: 
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7.  The data will be presented in 11 different columns as shown below:  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8. Rename the columns to the headings below:  
• COLUMN 1 – DISTRICT ID 
• COLUMN 2 – TRA  
• COLUMN 3 – APN 
• COLUMN 4 – ZIP CODE 
• COLUMN 5 – ADDRESS 1 
• COLUMN 6 – ADDRESS 2 
• COLUMN 7 – ADDRESS 3 
• COLUMN 8 – ADDRESS 4 
• COLUMN 9 – ADDRESS 5 
• COLUMN 10 – ADDRESS 6 
• COLUMN 11 – APN TYPE  
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Attachment B 
 
 

             Record layout for direct charges files  
       
 Field          
 Number Field Description Field Type Widths Remarks  
 1 Type of Tax Alpha/numeric 2 Required   
 2 Parcel Number Alpha/numeric 8 Required: All 8  
 3 Assessment Amount Alpha/numeric 10 Decimal Required   
 4 City/ District Code Alpha/numeric 4 Required *  
       

Example of Data Layout: Data= "T1"ll"01011127"ll1234.55ll"051"  
 
*The file must be in “ASCII Delimited Text” format.  The delimiters should be tab (II) and Double 
quotes (“).  All files must be in the correct text format; the incorrect format will result in a failure to 
attach your levy to the secured tax roll.  
 

SAMPLE OF TEXT DATA FILE 

 
 
 
*The data files must be provided in the following format:  

• District-Tax Type-City or Special District 
o Example: 051-R1-City of Anaheim or 749-CE-WRCOG 

• If there are multiple tax types in data file, please list accordingly 
o Example: 051-R1, R2, R3, R5-City of Anaheim 

SAMPLE DATE FILE NAME 

 
 
*Note: For new assessments, contact Israel Guevara at (714)834-3839 or 
Israel.Guevara@ocauditor.gov  for your tax type code and district number.  
 

mailto:Israel.Guevara@ocauditor.gov
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Attachment C 

 
Direct Charges FY 2026-2027 

 
Name of City/Special District:        
 
List all assessments by name and tax type. 
 
Assessment Name         Tax Type     

Contact Name         Phone #     

 
Assessment Name         Tax Type     

Contact Name         Phone #     

 
Assessment Name         Tax Type     

Contact Name         Phone #     

 
Assessment Name         Tax Type     

Contact Name         Phone #     

 
Assessment Name         Tax Type     

Contact Name         Phone #     
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Attachment D 
Direct Online Submission 

 
 

The Orange County Auditor-Controller direct charges upload system allows cities, special 
districts and authorized consultants to upload direct charge files and signed board resolutions.  
Access https://epts.ocauditor.gov/direct/login and sign in with the account information provided 
to you last year.  If you do not have an account, please contact us for setup.  Below, we use the 
County as an example to demonstrate. 
 
Login ID: Please use the same login ID from last year (see login ID listing).  This is same as the 
Account ID displayed in the profile.  If your district is not on the list, please contact us for setup. 
 
Password: Please use the password you created last year.  If this is a new account, the initial 
default password is “Password”+DistID.  For example, the default login for the County is 
OCOUNTY and PasswordB001.  Upon initial log in, we strongly recommend that you change the 
password.  Password is eight-character long, must have upper and lower case, and the District 
ID.  For password reset, utilize the “forget password” feature or contact us. 
 

 
 
Upon logging in, you will be taken to the Dashboard.  Navigate via tabs and links for different 
functions and information on this page. 

https://epts.ocauditor.gov/direct/login


 
Page 10 of 13 
 

 

 

View & Upload Files: Use this function to upload the direct charge files and signed board 
resolutions.  Only correct file types (.txt, .pdf, .doc) can be accepted.  You only have the 
capability to upload and view files.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Data files to be uploaded need to be in the following format:  
o Data File:  District-Tax Type-City or Special District 

Example:  051-R1-City of Anaheim or 749-CE-WRCOG 
o If there are multiple tax types in data file, please list accordingly 

Example:  051-R1, R2, R3, R5-City of Anaheim 
 

• Select Attach File and locate the file you want to upload.   

 
 
 
 
 
 
 
 
 
 
 

 
 
 
                         

• Confirmation will be given once your files are successfully uploaded with the correct file 
type.  
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• You can view the files that have been successfully uploaded to the district folder by 
clicking on your folder.  Once uploaded, files cannot be deleted or changed.  Contact us 
if you require deletion of an incorrect or erroneous file.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Public Folder:  You can view and download any documents uploaded by the Orange County 
Auditor’s office such as the Direct Charges Letter, submission instructions, and the Parcel Listing 
files. 
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Profile: Contains the Account ID, District Name and District ID which are created and assigned 
to you by the Orange County Auditor’s office.  You must update the primary contact person’s 
information (first name, last name, email and primary phone number) which must match the 
information submitted with Attachment C.   
 

 
 
 
 

 
 
 
 
 
 
 
 
 

 
 

• Select Edit and update the fields with the information that matches the same contact 
information submitted with Attachment C for the district.   
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Change Password: Enter your current password that was provided to you and then update your 
new password following the prompts. 
 
Password requirements:  8 characters, must include an upper- and lower-case letter, and a 
number. 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 


